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Introduction

1.1 About the Wide Format Scanning Plug-in
In recent years, digital image technology has made wide format scanners an affordable solution
for many graphics businesses. In fact, wide format scanners as input devices offer so many
advantages that they are hard to overlook. Usage of Adobe Photoshop on Apple Macintosh or
Windows platforms is widespread among graphics professionals and this software is designed
to supply convenient, direct and problem-free access to Wide Format Scanning input while
working with Adobe Photoshop.
The software is designed as a plug-in, meaning it is a full software program that extends the
functionality of the Adobe Photoshop program by enabling access to Wide format scanning.
Install the program into Adobe Photoshop’s plug-in folder and it immediately becomes
accessible through the Photoshop main screen. You select the application through Photoshop’s
File menu and thus add advanced scanning to your workflow.
In Photoshop terms, this is an “Import Plug-in” meaning it imports images from the scanner into
the Photoshop image editor. You can then use Photoshop’s wide range of image manipulation
options, just as if you had opened an image file from your hard disk.
Here are some of the main features obtainable through this application:
• Easy scanning directly into the Adobe Photoshop interface without leaving Photoshop.
• Standardized paper size options fitted to popular input media sizes.
• Custom paper size options, enabling full control over non-standard input media sizes.
• Offsetting – Selecting specific areas on the original for scanning.
• Advanced tonal adjustment features at scan time.
• Easy adjustment of Brightness, Contrast and Blur.
• Special scan modes fitted to different/specific original types.
The Plug-in can be obtained in a Macintosh version or a Windows version. For Macintosh users,
this software is a necessary link between a Wide Format Scanner and an Apple Macintosh
platform, because the standard scanning software normally supplied with your Wide Format
scanner is designed for Windows. For Windows users, the software is a handy scanning
interface specifically useful when working in Adobe Photoshop.
Screen illustrations in this user guide display the Macintosh user interface. Dialog structures,
options and functionality are identical in both the Macintosh and Windows versions and this user
guide applies for both.
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1.2 Installation
It is recommended to read Adobe Photoshop’s documentation regarding Plug-in applications
and their installation.
Plugin installation
Macintosh version:
For installation instructions, please refer to the separate Installation Guide that is downloadable
with the plugin from the web.
Windows version
Unpack the file you downloaded from the web and double click the setup.exe file. Follow the
installation instructions that appear on your screen.
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2. Getting Started
2.1 Starting the application from Photoshop
This wide format scanning application is constructed as a plug-in to Adobe Photoshop, and
must be accessed through the Photoshop user interface. In Adobe Photoshop terms, wide
format scanning is an “Import” action in which the scanner imports images into the Photoshop
editor. Once in the editor, the image can be manipulated as if it were opened from the hard disk.
Follow the following steps to start the Wide Format Scanning plug-in.
⇒
⇒
⇒
⇒

Start the Adobe Photoshop application
Select File -> Import
From the list of import sources, select Wide Format Scanning as shown in Figure 2-1 below.
The Wide Format Scanning interface is shown in Figure 2-2.

Fig. 2-1: Start the Wide Format Scanning Plug-in in Photoshop
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2.2 An overview of the Plug-in user interface
Scanning Settings

Preferences Settings

Prescan Window

Figure 2-2

The Wide Format Scanning dialog can be divided vertically into three logical areas.
On the dialog’s left side you find the main options, i.e., those related to the scanning settings
including image quality parameters and control (start/done/prescan) buttons. This adjustments
option group area contains options related to the current scanning Mode selected in the topmost
option box. Therefore, the available adjustment options and the appearance of the adjustment
group area changes with your selection of scanning Mode. In the above figure, the adjustment
options for the RGB (color) mode are displayed.
The middle section of the dialog contains central preference settings, i.e., your choice of
measurement units and your choice of how the original is going to be inserted into the scanner.
Your current paper size settings are displayed below the unit option area, using the
measurement units you selected just above. Here you select your color space calculation
method i.e., NTSC or sRGB.
The Prescan Window allows you to define your scan window (capture area) directly and
visually on screen. When you press the PreScan button, the image is loaded in the Prescan
Window and a outlined box shows you the image capture area as defined by your current paper
size and offset settings. You can then redefine both paper size and offsets by dragging the box
and dragging its corners/edges with the mouse.
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2.3 Scan into Photoshop – Basic Steps
The following is a quick overview of the minimum you must perform to scan an image into
Photoshop. In the next chapter “Scanning Options and Features”, we will look at each of these
steps in greater detail, focusing on the available possibilities for achieving the best scan quality
for your current original. For now, let’s just see how the plug-in works:
1. Start the Adobe Photoshop application.
2. In the Adobe Photoshop interface, select File > Import.
3. Select the “Wide Format Scanning” import device
4. The Wide Format Scanning interface pops up
5. Set your scanning Mode. Here you must decide if you wish to perform color, graytone of
B/W scanning. With B/W scanning, you can select from different automatic image
enhancement modes. Scanning modes, together with their specific characteristics and
usefulness, will be described in the next chapter.
6. Set your scan Resolution, i.e., the image resolution in the resulting Photoshop image. You
can select one of the common resolutions or else specify your own resolution. Tips on
choosing the best resolution for your specific job will be given in the next chapter.
7. Set the Paper Size and position of your scan. The scanner needs this information to
determine the size of the area you want captured. It would be uneconomical to scan too
much background by over estimating original dimensions and undesirable to scan only a
portion of the image you wish captured. You can select commonly used standard sizes or
you can customize new sizes for special originals. You can also pick out a limited area for
scanning using Offsets, Width and Height settings. You can also press the PreScan button
and then redefine the capture area’s size and position (width, hight, offsets) directly on the
image by dragging the outlined box with your mouse. These features will be described in
the next chapter.
8. Select your insertion method in the Paper Load option group area. Central loading is
recommended for most sizes and guide marks for many standard sizes are printed near the
scanner insertion slot at the center loading point. Make sure your setting complies with the
actual insertion position of the original (side or center).
9. Adjust your scanning mode through its specific adjustment parameters. Figure 2-2 shows
adjustment parameters for the RGB (color) mode. Brightness, Contrast, Gamma values and
a color Blur filter can be set/adjusted with the RGB mode. Other parameters apply for BW
and Adaptive modes. Mode and tonal adjustments are described in detail in the next
chapter.
10. When you have made all your settings, select the Scan button on the dialog’s lower left
side.
11. Check the image input by the scanner. If you are satisfied with your results, i.e., image size,
adjustments, etc., then select the Done button. This action will remove the Wide Format
Scanning dialog and return all control to Photoshop’s editor with the scanned image loaded.
12. If you are not satisfied and wish to repeat the scan, make the revised adjustments and
select the Scan button. Repeated scanned images will be opened in new Adobe Photoshop
edit windows, or as long as the Wide Format Scanning interface remains active. This
enables you to re-scan an original with different settings, compare the results at the end and
then choose the best one for further editing in Photoshop.
13. The <ESC> key can be used at any time to back-step and finally abort the Wide Format
Scanning dialog. Hitting <ESC> will also interrupt an ongoing scanning process.
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3. Setting Scanning Options and Features
In the last chapter, we covered the steps necessary to scan into the Photoshop editor. You
probably recall, that the bulk of the steps mentioned involve setting options relevant to your
scanning task and your current original. In this chapter, we will look at each option separately
and describe how best to use them. The options described here control your scanner’s built-in
enhancement features and if you use them optimally, they can make a big difference to your
end result.

3.1 Scanning Modes and Adjustments

Fig. 3-1: Scan Mode Selection
The scanning mode is your central option. This is where you evaluate the kind of original you
are scanning and determine the kind of image you wish produced. Some of the available
scanning modes can be used to enhance the quality of unclear and low contrast originals. With
the adaptive modes, the scanner makes scan-time assessments of your drawing using 2Dimensional Adaptive Thresholding in which graytone information on each pixel is stored and
compared with its neighboring pixels in order to rebuild a higher image quality. Copy modes
create optimal black-and-white images for output on printers. The color and graytone modes are
for reproducing images with all the colors/tones intact.
Each scanning mode has its own set of adjustments options. Only adjustments relevant to your
selected scanning mode will be displayed in the dialog’s adjustment area. Adjustment options
relevant to the scanning Mode appear immediately in the Adjustments area when you select or
change your scanning Mode.
Each scanning Mode, its characteristics, typical usage, and adjustment options are described in
the next sections. Use these descriptions to find and adjust the scanning Mode that best suites
your particular original or scanning task. A complete overview of the modes, recommended
usage and relevant settings can be found at the end of this section.
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3.1.1 Scanning in B/W Threshold Mode
This mode uses a threshold to determine whether a pixel is black or white. Use this mode for
drawings and line art. You set the threshold value in the Adjustments area.
Setting the Threshold
When a camera in the scanner looks at a drawing, it converts what it sees to graytone levels
between 0 and 255 with the dark tones represented by low values and the light tones by high
values and middle tones by middle values. When scanning at a specific threshold all gray tones
below the selected threshold value will be represented as black pixels, and all gray tones above
will be represented as white pixels.
For example, if you have a very faded line drawing, you might want to increase clarity by setting
a high threshold, thus forcing more shades of gray to black. In other words: the higher the
threshold, the darker the result.
The Threshold value, ranging from 0 to 255, can be set in the Adjustments – Threshold edit
field.
⇒ Set the threshold value in the Adjustments area edit field using the guidelines above.
⇒ Evaluate your setting in the resulting image loaded in the Photoshop window.
⇒ If the image is too dark, repeat the process with a lower threshold and if you wish it darker,
try a higher threshold

Fig. 3-2: Drawing Scanned at Fig. 3-3: Same drawing at
threshold setting of 45.
threshold setting of 210
•

Blur
The Blur filter blends graytones and thus removes unwanted “noise” from the image. The
value you set determines the degree of graytone blending.

•

Sharpen/Soften Filter: The Sharpen/Soften filter intensifies or “mellows” identified edges.
The value you enter in the filter field determines the degree of sharpening/softening.
Positive values sharpen and negative values have a softening effect. Using this filter in
combination with the Blur Filter can sometimes enhance image quality by first blurring away
noise and then sharpening the result.
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3.1.2 Scanning in B/W Adaptive Mode
In this mode the threshold adapts to darker or lighter areas in the original as opposed to the
B/W threshold mode that uses a singular global threshold. The BW Adaptive mode is suitable
for scanning all kinds of line drawings including difficult blueprints, brown transparencies
(sepias), etc. A stained or faded original can be renewed as good sections are retained and bad
ones clarified. This mode provides minimum file sizes and is, thereby, well suited for digitizing.
The BW Adaptive mode uses the scanner’s 2D Adaptive technology.
Setting the adaptive Level
Adaptive Level works like a threshold - the lower the value, the more of the background is
picked up during scanning. You set the adaptive Level in the Adjustments area.

Fig. 3-4: 2D - Adaptive Scan – Before(original) and After(scanned image)
•

Blur
The Blur filter blends graytones and thus removes unwanted “noise” from the image. The
value you set determines the degree of graytone blending.

•

Sharpen/Soften Filter: The Sharpen/Soften filter intensifies or “mellows” identified edges.
The value you enter in the filter field determines the degree of sharpening/softening.
Positive values sharpen and negative values have a softening effect. Using this filter in
combination with the Blur Filter can sometimes enhance image quality by first blurring away
noise and then sharpening the result.

3.1.3 Scanning in B/W Copy Modes
B/W Copy Normal, BW Copy Photo, B/W Copy Adaptive
The Copy modes incorporate Dual 2D-Adaptive enhancement processing with different
combinations of ADL+ Error Diffusion Halftoning, 2D-Background suppression, 2D-Auto edge
enhancement and 2D-Adaptive thresholding. The copy modes are ideal scanning wide format
documents that are intended for re-printing. The ADL+ Error Diffusion Halftoning supports
visibility of graytones in printed output by adding toned shades of gray in regions between black
and white.
Setting the adaptive Level
You set the adaptive Level in the Adjustments area. Adaptive Level works like a threshold - the
lower the value, the more of the background is picked up during scanning.
•

Blur
The Blur filter blends graytones and thus removes unwanted “noise” from the image. The
value you set determines the degree of graytone blending.

•

Sharpen/Soften Filter: The Sharpen/Soften filter intensifies or “mellows” identified edges.
The value you enter in the filter field determines the degree of sharpening/softening.
Positive values sharpen and negative values have a softening effect. Using this filter in
combination with the Blur Filter can sometimes enhance image quality by first blurring away
noise and then sharpening the result.
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3.1.4 Scanning in Graytone Mode
In this mode 256 gray levels are recognized for each pixel (1 byte, 8 bits per pixel). Gives good
reproduction of complicated B/W images like B/W photos. You adjust Contrast, Brightness,
Gamma and Blur in the Adjustments area.
Graytone Mode adjustments
•

Brightness
Use brightness to compensate for a light or dark original being scanned. Numeric values for
brightness are defined by clicking on the up/down arrow buttons or by editing directly in the
fields. The normal position is zero with negative values for reducing brightness and positive
values for intensifying brightness.

•

Contrast
Contrast is the range between light and dark in an image. An image with little midtone
detail, heavy shadows and bright highlights has too much contrast and, conversely one
mainly with midtone detail, grayish shadows and highlights has to little contrast. Numeric
values for contrast are defined by clicking on the up/down arrow buttons or by editing
directly in the fields. The normal position is zero with negative values for reducing contrast
and positive values for adding contrast.

•

Gamma
Gamma adjustment can be used to make tone distribution lighter or darker in an image with
emphasis on midtones rather than the extreme (black, white) ends. Turn up the Gamma
value to lighten the image tones and turn down the Gamma value to darken the tones.

•

Blur
The Blur filter blends graytones and thus removes unwanted “noise” from the image. The
value you set determines the degree of graytone blending.

•

Sharpen/Soften Filter: The Sharpen/Soften filter intensifies or “mellows” identified edges.
The value you enter in the filter field determines the degree of sharpening/softening.
Positive values sharpen and negative values have a softening effect. Using this filter in
combination with the Blur Filter can sometimes enhance image quality by first blurring away
noise and then sharpening the result.

3.1.5 Scanning in RGB Color Mode
24 bit true color mode for capturing all of the image’s colors. Distribution of tones can be
adjusted in the Adjustments area.
RGB Mode adjustments
As with the Graytone mode, you can adjust Contrast, Brightness, Gamma and Blur in the
Adjustments area, but here, the adjustments apply to the color tone channels.
•

Brightness
Use brightness to compensate for a light or dark original being scanned. Numeric values for
brightness are defined by clicking on the up/down arrow buttons or by editing directly in the
fields. The normal position is zero with negative values for reducing brightness and positive
values for intensifying brightness.

•

Contrast
Contrast is the range between light and dark in an image. An image with little midtone
detail, heavy shadows and bright highlights can have too much contrast and, conversely
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one mainly with midtone detail, dull shadows and highlights can have little contrast.
Adjusting the contrast can make colors more vivid and realistic. Numeric values for contrast
are defined by clicking on the up/down arrow buttons or by editing directly in the fields. The
normal position is zero with negative values for reducing contrast and positive values for
adding contrast.
•

Gamma
Gamma adjustment can be used to make tone distribution lighter or darker in an image with
emphasis on midtones rather than the extreme (black, white) ends. All three (Red, Green ,
Blue) color channels are effected together with each change. Turn up the Gamma value to
lighten the image tones and turn down the Gamma value to darken the tones. For example,
if you are scanning a picture of a blue sea, a lower Gamma value will change the sea’s
color towards a darker marine blue, and turning up the Gamma value will change the
normal sea color to a light sky-like blue.

•

Blur
The Blur filter blends graytones and thus removes unwanted “noise” from the image. The
value you set determines the degree of graytone blending.

•

Sharpen/Soften Filter: The Sharpen/Soften filter intensifies or “mellows” identified edges.
The value you enter in the filter field determines the degree of sharpening/softening.
Positive values sharpen and negative values have a softening effect. Using this filter in
combination with the Blur Filter can sometimes enhance image quality by first blurring away
noise and then sharpening the result.
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3.1.6 Overview of Scanning Modes*
Mode*

Usage

Adjustments

BW Threshold

Drawing and lineart

BW Adaptive

Scan to file of Line drawings difficult
blueprints, sepias, faded/stained
drawings.

BW Copy Normal

Halftone copy to print of all normal
originals with a relatively good quality
image.

BW Copy Photo

Halftone copy to print of continuos shades
of gray such as in photos.

Threshold value
Histogram.
Despeckle,
Holefilling
Sharpen/Soften*
Blur*
Adaptive Level
Back. Suppression*
Despeckle,
Holefilling
Sharpen/Soften*
Blur*
Adaptive Level
Sharpen
Soften
Blur
Adaptive Level
Sharpen
Soften
Blur

B/W Copy Adaptive

Halftone copy to print of Sepia, Blueprint,
and other originals with heavily distorted
foregrounds and backgrounds in which
the shades that create image noise are
close to the shades that represent the
image’s data and the two are hard to
differentiate.

Adaptive Level
Sharpen
Soften
Blur

Graytone

Monochrome image reproduction with all
tones retained.

RGB Color

True Color image reproduction

Contrast
Brightness
Lightness
Brightness
Contrast,
Lightness,
Saturation, Balance,
Gamma

* The availability of specific scanning modes will depend on your scanner model.
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3.2 Setting Scanning Resolution
Scanning resolution is the number of pixels per inch (dpi) in the end (scanned) image. An image
with a high resolution will contain more and thereby smaller pixels than an image with equal
dimensions with a lower resolution. High resolution images will therefore normally display more
detail and wider color ranges than low resolutions. However, high resolutions produce larger
files with the usual setbacks in relation to disk space, load time, etc.
Your selection of resolution will therefore depend mainly on how you intend to display the
image. For offset printing, high resolutions work best while for screen and web display, lower
resolutions will suffice. Normally, 300 dpi and above are considered high resolutions. High
resolutions can also be necessary if small details (like in maps) must be displayed clearly.
Often, your printing device documentation will contain recommendations about scanning
resolutions.
The image resolution should be determined before scanning i.e., before your original is digitized
and the image transformed to pixel data. Using Photoshop to increase resolution of an image
scanned at low resolutions will normally not improve the image’s quality.
Click on the Resolution list arrow to reach the list of available resolution settings. The Wide
Format Scanning plug-in offers two methods for setting resolution – Standard and User Defined.

Fig. 3-5: Setting the Scan Resolution
Standard resolutions are round value settings from 50 dpi and up to the highest resolution
supported by your scanner model. The application will detect your scanner model’s capabilities
and only valid resolutions will be listed. See the technical specifications that came with your
Wide Format Scanner for information on its maximum resolution capabilities.
User Defined (custom) Resolutions – Sometimes you will need to set the resolution to a
specific value in order to match your image with a specific display device, printer or software
application. Or, you may be working with another image already loaded in Photoshop and wish
to match the resolution of the new image with that of the existing one. If the resolution you need
is not among the standard resolutions then perform the following steps:
⇒ Click the User Defined option at the bottom of the resolution list.
⇒ A new dialog with a single edit field appears in which you can write a specific resolution.
Only whole numbered resolutions within the range of 50 and the scanner’s maximum
resolution are valid.
⇒ Your new resolution is called “User Defined” in the resolution field and its value is displayed
will be displayed with the User Defined setting in the resolution list.
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User defined resolution value

Fig. 3-6: User Defined Resolution
Your Adobe Photoshop manual also gives pointers on determining image/ scanning resolutions.

3.3 Setting the Original’s Paper Size
In order to perform effective and high quality scanning, the scanner needs to know the size of
the area you want to capture. In many cases this will be equal to the size of your original. This
size is called the Paper Size and it directly defines the “scan field”, which is the area on the
image that the scanner will capture. One could of course choose to let the scanner digitize
everything within it’s maximum width, always capturing data over the original’s edges, and then
crop away the part you don’t need. But with this method you would at best produce a lot of
unnecessary and unusable data and at worse disturb effective thresholding and adaptive
processing.
Sometimes, you will want to scan only a portion of the whole original. This can be performed by
setting a Paper Size that best fits that portion you wish scanned and then repositioning the scan
field through Offsets. You can also make the Paper Size and Offset settings visually through a
prescan of the original.

3.3.1 Paper units
Before selecting a paper size, select the measurement unit (Paper Units) that best fits your
purpose. Paper sizes can be entered and displayed in Inches or centimeters. Paper Units are
marked above the scanner’s insertion slot, so you can make size measurements directly off the
scanner. Your choice of Paper Unit will be reflected in the Paper Attributes (display only) option
group just under the Paper Units group.
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3.3.2 Paper Attributes
The Paper Attributes value group is a display-only area that informs you of the current Paper
Size dimensions and offsets. Whether using standard or custom sizes, paper dimensions are
displayed in the measurement units selected in the Paper Units option group.
Standard Size List

Paper Units

Dimensions & Offsets

Fig. 3-7: Setting a standard Paper Size

3.3.3 Setting Standard Sizes
The available standard sizes will cover most of your needs. Click on the drop box arrow to view
the available predefined standard sizes. Portrait and Landscape positioning is indicated by the
letters “P” and “L” attached by hyphens to each standard size, for example, A4-P, Letter-L, etc.
The Paper Size’s actual dimensions, given in inches or centimeters are displayed to the right in
the Paper Attributes group.

3.3.4 Setting User Defined (custom) Sizes
Sometimes you will have an original that does not fit with any standard size or you may wish to
crop an original to special dimensions in a specific image area. You can do both of these
through the “User Defined” option, which is selectable at the bottom of the Paper Size List as
shown in Figure 4-7. Here’s how you set a custom size.
⇒
⇒
⇒
⇒

Click on the down arrow in the Paper Size field.
Select User Defined at the bottom of the size list.
Enter Paper Size dimension values in the new dialog.
Enter your Offset values for scan area repositioning or leave them at 0,0 for normal top left
corner positioning. (Details follow below)
⇒ Select OK. Your custom Paper Size (named simply “User Defined”) becomes the current
Paper Size.
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Fig. 3-8: Setting a custom Paper Size
Note: User Defined Sizes (and offsets) can be set visually with your mouse after a PreScan.
See the next section for details.
The User Defined paper size retains its settings until they are changed. If you need a new
custom Paper Size, repeat the process above and overwrite the previous values.
Move the scan area with offsets (X,Y)
The scanner’s capture area is the area picked up by the scanner’s cameras and the Paper Size
defines its size. Normally and per default, the scanner’s capture area is positioned over the
original’s top left corner.
The X and Y Offsets in the Paper Size dialog, allow you to move the position of the scan
capture area, which means that you can point out any specific area on the original for scanning.
The X and Y values you enter are like coordinates on a map and the scanning start-point will be
shifted from the original’s top left corner to the position indicated. Scanning itself will then cover
the area specified in the dimensions fields. This could be a standard size or a custom size. For
example, you might need to capture a logo imprinted somewhere in the middle of a large poster.
Example : Capture the Logo on a large Poster
⇒ Select the User Defined paper size option from the list of paper sizes.
⇒ Set the paper size to 5” x 5” or any size slightly bigger than the logo. This is the size of the
scanner’s capture area.
⇒ Use a ruler to measure the logo’s position, using the measurement units selected in the
Paper Units area. You measure from the 0,0 point which is at the original’s top left corner.
⇒ Calculate and enter your offset coordinates so that your scanner’s capture area (Paper
Size) covers the logo. The coordinates you enter will indicate the position of the scan
capture area’s top left corner.
The above procedure is illustrated in Figure 4-9. The scan capture area is normally positioned in
the top left corner of the original with offsets at X = 0 and Y = 0. The scan capture area
dimensions (Paper Size) are set to 5” x 5”. The offsets are then set to 8,3” in the User Defined
Paper Size dialog. This moves the effective scan capture area 8” to the right and 3” down in
relation to the original’s top left corner.
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Note: There is a much easier way to set User Defined offsets (and sizes). They can be set
visually with your mouse after a PreScan. See the next section for details.

Scan capture area

Fig. 3-9: Placing a Scan Window with Paper Size Offsets
Remember :
• The offset coordinates use the measurement units specified in the Paper Units area
(inches, cm or scanner units.)
• Control your Paper Load setting with the original’s position in the insertion slot. The Paper
Load option will be described in the next section.
• The X and Y offsets should be set to zero for normal scanning of whole originals, i.e. with
Paper Size dimensions that match the original’s size.

3.3.5 An easier way – Set Paper Size/Offsets Visually
WIDEcapture incorporates a PreScan option that lets you define the capture area visually on
your screen with your mouse.
⇒ Press the PreScan control button at the bottom of the main dialog.
⇒ An image of your original is loaded into the Prescan Window on the right.
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⇒ A box in the window outlines the Paper Size and the offset, i.e., the capture area position as
defined by your current Paper Size and Offset settings. See below:

Fig. 3-10: Prescaned image with Paper Size and position outlined
⇒ Use your mouse to adjust the Paper Size and/or offsets. Drag the corners/edges of the box
to resize the Paper Size.
⇒ Hold the mouse down as you point in the box and drag to position the capture area on the
image.
⇒ Notice that your settings under Paper Attributes change in accordance with your
adjustments to the outlined box.

3.4 Setting the paper feeding parameter
The Paper Load setting is found at the bottom right corner. Here you determine if you prefer
center loading or loading from the scanner’s side. Center loading works best with most originals
and is strongly recommended Side loading is convenient when using specific measurements for
size and offset settings because the side aligned units ruler imprinted just above the scanner’s
insertion slot lets you read the size off the scanner.
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4. Trouble Shooting – Common Problems
No Scanner found - The Wide Format Scanning plug-in dialog tells you that no scanner is
detected or known. This is likely because the scanner was not turned on and ready when you
booted your computer. The scanner must be turned ON prier to booting for SCSI connections to
take effect. If using FireWire or USB – see the scanner installation guide and plugin installation
guide and check that setup was performed correctly. See the next section if the above
procedures do not solve the problem.
Scanner ON still no scanner found – If you still get the message that no scanner was
found/detected, then try to close and restart Adobe Photoshop. If you have just installed the
plug-in, Photoshop needs to detect it’s existence in the plug-in folder when it starts up.
Blank (white) image created after scanning - Check the Paper Load (Center/Side) setting. If
your original was not placed according to this setting, for example, you inserted from the center
but your setting is on “Side Load”, then the scanner will scan and capture the white background
plate. Make sure your Paper Load setting complies with your original’s actual insertion position.
If the Paper Load setting is correct then you may have “exaggerated” your Threshold or
Adaptive Level settings, rendering them much too extreme for the image being scanned.
Modes described in this manual not in Mode list – If you are looking for a scanning Mode
described in this manual and it does not appear as an option in the Mode List, then it is probably
not supported by your scanner model.
Part of the scanned image is cropped out – Check the Paper Size setting. The scanner only
captures the size defined by the Paper Size Width and Height settings. Use the PreScan button
to see how your settings will appear in your output.
Large white frame around the scanned image – Check the Paper Size setting. The scanner
captures the whole size defined by the Paper Size Width and Height settings. If these setting
extend the capture area over the originals dimensions, then the scanner picks up the white
background plate.
Slow and jumpy scanning - The more available RAM in Photoshop, the smoother the
Scanning Plug-in will process data and run. If the progress of the original through the scanner
seems slow and in jerky movements the problem could be that Photoshop does not have
optimal 'memory cash' size. Follow the instructions below to optimize your system:
• See Help > Help Contents....
• Under Index, type Memory and go to the bottom of the help page
• Click on: ... Increase the application memory size. The help text that appears (on
Photoshop for Macintosh) is copied below:
1) Quit Adobe Photoshop if it is running.
2) Start all applications - except Photoshop - that you must use simultaneously with Adobe
Photoshop. Keep in mind however, that running other applications with Photoshop uses RAM
that could be allocated to Photoshop.
3) Return to the 'Finder'. Choose 'About this Computer' from the Apple Menu.
4) Note the 'Largest Unused Block' value (You will need this value in step 6). This value shows
the amount of memory currently available.
5) In the 'Finder', select the 'Adobe Photoshop Program Icon' (Not the folder or the alias icon).
And choose File > Get Info.
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6) In the Adobe Photoshop Info Window, set the Preferred Size option to no more than 90% of
the 'Largest Unused Block value' you noted in step 4.
7) Close the Adobe Photoshop Info Window.
In tests the Preferred Size was increased from 22Mbyte to 102 Mbyte. Scanning of a picture
(A2-L 300DPI 24-bit color) went from 7 min to 47 seconds, and the scanning became smooth.
Less RAM will also work fine, but the more RAM Photoshop has available, the faster the
scanning will be preformed.
Not enough room on disk - Photoshop uses temporary space on the hard disk to store
scanned pictures. If the picture size is too large to be saved on the hard disk, scanning is not
performed, and a message appears" No scanning performed, Scratch Disk probably too small".
If you have more than one hard disk the all should be in use. To control this, choose menu File:
Preferences: Plug-Ins and Scratch Disks...
Note that Photoshop uses about 25% more than the theoretical size of the picture, when
temporarily saving the picture on the hard disk. Example: An original with Paper Size = A0-P
(33.1 Inch * 46.8 Inch) scanned at 300 DPI in RGB Color (3 byte per pixel) mode will have a
theoretical size of 33.1*300 * 46.8*300 * 3 = 400 Mbyte. Despite this, Photoshop would use
500 Mbyte for storing such a scanned picture.
Other Problems related to the scanner
See the Operator’s Guide that came with the scanner.

